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Overview of General Ledger 

The General Ledger module (GL) of the MultiSite Suite program provides an 
easy, efficient way to create and manage journal entries and related 
accounting details in one integrated computerized system. It also enables you 
to view account summary and detail information, generate financial reports, 
and exchange accounting details with the Cash Management and Tenant 
modules of the MultiSite Suite. 

The General Ledger module has the following features: 

General Features 

 Microsoft Outlook® user interface design, for simplicity and consistency 
with other MultiSite modules. 

 Compatibility with Microsoft Office 97®, 2000, and XP. 

 Filters that provide custom views, so that users can see only the 
information they need to perform their own jobs: 

Property managers and field personnel can view records but not add 
or modify batches (journal entries). 

Office staff can enter and modify batches and budgets, as well as 
view records. 

Views can be filtered so that property managers can see only those 
records pertaining to their own sites. 

 13-year periods are provided for each year (period 13 can be used for 
year-end accrual entries). 

 Accounting periods remain open; they are never closed. 

You can post to any period (past or future) 

To ensure accuracy, the system prompts you when you post entries 
to previous or future periods. 

 Security levels limit access to sensitive information, as needed. 
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 Unlimited history of activity can be retained. 

 Automatic real-time or Batch posting of information from the Tenants 
module of the MultiSite Suite to the General Ledger module. 

Account Maintenance Features 

 An unlimited number of chart account templates (company divisions) can 
be used. 

 An unlimited number of accounts can be added per template. 

 Alternate account numbers and descriptions can be used for external 
reporting (for example, reports can be generated using the HUD 
Standard Chart of Accounts without affect internal reporting). 

Batch Entry Features 

 Detailed batches (journal entries) can be prepared in Microsoft Excel® 
and then imported into GL and posted, thus saving data entry time. 
Imported Excel files remain attached to the corresponding GL batches 
for future reference. 

 Standard batches can be defined ahead of time and posted as needed. 

 Entries can be copied and used for subsequent accounting periods. 

 Entries can be posted in one period and reversed in another. 

 The data entry screen includes fields for UnitID. 

Data Retrieval & Viewing Features 

 On-screen display of account records in either Trial Balance or Operating 
Statement formats. 

 Detail line items are easily displayed by double-clicking lines of more 
general information, such as monthly account totals. 

 Variances can be explained by adding free-form comments to any 
account for a given year. 
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Reporting Features 

Fast, easy generation of reports that can be viewed, printed, exported to 
Excel, or sent as an e-mail attachment from one simple window. 

The standard reports that come with the GL module include the following: 

 Trial Balance 

 General Ledger (for all or selected accounts) 

 Balance Sheet 

 Income Statement 

Actual vs. Budget 

Actual vs. Prior Year 

12 Month 

 Operating Statement (Actual vs. Budget) 

 Cash Flow 

 Budget 

Budgeting Features 

 Budgets can be entered individually or imported from Excel. 

Features that MultiSite GL Does Not Have 

 Cannot do simultaneous cash and accrual account on the same site. 

 Limited to one segment for each General Ledger account; cannot use 
sub-accounts. 

 Consolidation reporting is not currently supported. 
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Logging Into General Ledger 

 To log into the General Ledger module, do the following: 

1 On your regular Windows® Desktop, double-click the MultiSite 
shortcut. 

 

The system connects to a remote server via the Internet.  

A login window appears.  

 

2 If it is not already displayed, enter your user name in the User Name text 
box. 

3 Keep the default Current Period (the current global period for general 
ledger activity). 

 
Note: Only users with special administrative rights to the GL module 
can change the date in the Current Period text box of this window. 

4 Click OK. 

The default main screen for GL appears, as shown in the next section, 
Navigating in General Ledger. 
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Navigating in General Ledger 

The modules in MultiSite Suite are designed to look like Microsoft 
Outlook®, for simplicity and familiarity. 

When you first log into GL, the following screen automatically appears: 

 

 

 

This default screen is already set up to search for and display account 
summary information. You would see the same screen if you clicked the 
Inquiry folder under Views (for more information, see Viewing & Printing 
Account Summaries). 

Label Bar/Slider Bar Sections 

GL is made up of 3 sections—one for each type of activity: 

 Views for displaying various types of account information 

 Actions for managing account information (adding, updating, deleting, 
exporting, and so forth) 

status bar 

buttons that open other 
MultiSite modules 

label bar 

slider bar 

Exit button 

User Preferences button 

Online Help button

Column 
headers
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 Reports for generating, printing, exporting, and/or sending reports 

To navigate to one of these three areas, click on the corresponding label bar. 
The label bar slides to the top, revealing the slider bar area underneath. You 
click the different icons in the slider bars to display different views of 
accounts (Views), perform different account management tasks (Actions), or 
generate different types of reports (Reports).  

 
Note: When you first click on a label bar, the other parts of the main 
screen remain in their previous view until you click an icon inside the 
newly-opened slider bar. 

Toolbar Buttons 

An explanation of each toolbar button is as follows: 

 Exit closes the GL program and returns you to the remote server 
Desktop.  

You can also click the Microsoft x button at the top right corner of the 
screen or choose Exit from the File menu. 

 User Preferences opens the user preferences window, enabling you to 
customize the records that you view and manage in GL (for more 
information, see Setting User Preferences).  

You can also access user preferences by choosing Preferences from the 
Tools menu. 

 Module buttons in the center of the toolbar open the other modules in 
the MultiSite Suite. 

 Online Help opens the online help for the program. 

Menu Commands 

An explanation of each command on the menu bar is as follows: 

 File menu enables you to change the setup of your default printer 
options (Printer Setup). You can also use it to exit the General Ledger 
module (Exit). 
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 Edit menu enables you to add a new batch (New Batch). This is the 
same as using the New Batch icon in the Actions slider bar (see Adding 
Batches). The Edit menu also enables you to add a new account. This is 
the same as using the Chart of Accounts icon the Views slider bar to add 
a new account (see Viewing, Adding, & Updating Accounts in Master 
Templates). 

 View menu contains various filtering commands that enable you to filter 
records that that you view in the system, thus shortening the amount of 
time that you spend waiting for the system to retrieve unneeded records. 
For a specific explanation of each View menu command, see the 
subsection Filtering Records for Customized Viewing in the topic Viewing & 
Printing Account Information (Views). 

 Tools menu enables you to do the following: 

Set user preferences, such as the default current accounting period or 
the parameters for some of the record retrieval filters (see Setting User 
Preferences).  

Rebuild your system layout files when you are experiencing technical 
trouble (see Rebuilding Layout Files).  

 
Note: This is something that customer support may ask you to do if 
you are experiencing system difficulties; it is not advisable to choose this 
option on your own. 

The Show Reminders command lets you set and display reminders to 
notify you of specific tasks to be done (see Setting Reminders). 

Display the Windows Notepad® or Calculator® (see Displaying the 
Windows Notepad & Calculator). 

 Help menu displays the online Help and the version number of GL. 

Click-level Sorting 

GL supports click-level sorting. This means that if you click on any of the 
column headers in a grid of records, all the records will sort according to that 
column header. The records sort in ascending order.  

For example, if you click the Activity column header in the Inquiry screen 
below, the records will sort according to Activity, with the smallest amount at 
the top and the largest at the bottom. 
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Status Bar 

The status bar at the bottom of the GL screen always tells you where you are 
in the program. Status information often appears at the top of grids of 
records, as well.  

For example, in the picture above, the type of view, Inquiry-Multi-Family, is 
displayed in the status bar, as well the name of the selected site, Elkin. The 
same information is displayed above the record grid, as well. 

Selecting Specific Records 

Many of the records in GL (as well as in other MultiSite modules) display 
records in a grid, either in the main screen panel or in a popup window. To 
put your focus on a specific record or row, click anywhere in the row. A 
small black triangle appears in the selection bar to the left of the record, 
indicating which record is selected, as shown below. 

column 
headers
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Navigating in Records 

You can move your focus from one text box or cell in a record to another by 
clicking with your mouse or pressing the Tab key on your keyboard. On 
some panels and windows, you can also press the Enter key on your 
keyboard. 

You can move from one row in a grid to another by clicking with your 
mouse or pressing the up or down arrow keys on your keyboard. 

You can also resize columns in grids by placing your cursor between two 
column headers and dragging your mouse pointer to the left or right. To save 
the new column size, so that the system displays it whenever you re-open the 
grid, click anywhere inside the grid after resizing it. 

Navigation Workflow 

Typically, after you log into GL, you click the label bar of the section you 
want to use, first (Views, Actions, or Reports). Then you click the icon in the 
corresponding slider bar and continue working in the panels that appear in 
the main screen or in popup windows that appear. 

Specific instructions for each procedure are included in this manual. 

Logging Out of General Ledger 

To log out of General Ledger, simply click the exit button on the main 
screen toolbar. You return to the remote server Desktop. 

To log out of the remote server, click the Start button on the Windows 
Taskbar and choose Log off [Your Username]. 

selection bar 
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Viewing & Printing Account Information (Views) 

When you first log into GL, the Views section opens by default, and the 
Inquiry view is automatically selected, as shown below. 

 

Views enable you to display and print account information in various 
combinations and formats. Each yellow folder icon corresponds to a 
different type of view. Descriptions of each are as follows: 

 Inquiry displays a summary view of every GL account for the current 
period. 

 Trial Balance displays the same information as Inquiry view, but it 
includes account variances and enables you to enter and view comments. 

 Operating Statement view is very similar to Trial Balance view, but it is 
displayed in operating statement format, grouping accounts by revenues, 
expenses, and balance sheet accounts. Any comments that you add to 
accounts in Trial Balance view appear in Operating Statement view too, 
and vice versa. 

 Chart of Accounts view displays the current master chart of accounts 
for each template or master list for each company division, (e.g., Multi-
Family, Corporate, etc.). It also enables you to add new accounts and edit 
existing accounts. 
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 Batch view displays all unposted or posted batches (journal entries) for 
the currently selected division (Multi-Family for most users). 

Filtering Records for Customized Viewing 

You can filter the records that the system displays when you view and 
manage accounts. In this way, you can shorten the amount of time that you 
spend waiting for the system to retrieve unneeded records, and you can scroll 
through records more efficiently. 

To filter views, you use the filtering commands on the View menu in the 
main screen menu bar. The procedures for each type of filter are as follows: 

Property Manager (Filter PM) 

To filter records according to the property manager that is in charge of the 
accounts you want to view, choose Filter PM from the View menu. 

Posted vs. Unposted Batches 

When viewing batches (see Viewing Batches), the system retrieves unposted 
batches by default. If you want to view posted batches, instead, choose 
Posted Batches from the View menu. To switch back to unposted batches, 
choose Unposted Batches from the View menu. 

Posted Batch Date Range 

Over time, a large number of posted batches are added to the GL database. 
Therefore, if you choose Posted Batches from the View menu, the number 
of records that the system retrieves might take a long time to display. Also, it 
might be difficult to find the batch you want in a long list. 

To display and view posted batches more efficiently, choose Filter Posted 
Batch Date Range from the View menu. To change the date range, specify a 
different one in the Preferences window (for instructions, see Setting User 
Preferences). 
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Office (Filter Office) 

To filter records according to the office that is responsible for the accounts 
you want to view, choose Filter Office from the View menu. 

Printing Records 

Most of the views in the MultiSite Suite can be printed. If a record can be 
printed, a print button appears on the toolbar, or you can use a Print 
command on the File menu. 

Viewing & Printing Account Summaries 

Inquiry view enables you to view and print summary information of all GL 
accounts for the current period. 

 To display a summary view of accounts, do the following: 

1 If the Views label bar isn’t already open, click on it to display the various 
viewing options. 

2 In the Views slider bar, click the Inquiry folder icon. 

A list of the sites is displayed in the center of the screen, as shown below. 
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Tip: You can change the list of sites that appears by selecting a different 
Default Division from the Preferences window (see Setting User 
Preferences). 

3 In the list of sites, click on the site containing the account(s) you want to 
display. 

The corresponding accounts are displayed in the main viewing panel, as 
shown below. 

 

Sites appear after 
you click Inquiry 
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4 To print the grid information, right click – choose print all rows. 

5 To view current-period activity details for a single record in the list, 
double-click the cell in the Activity column in the same row as the 
corresponding account number (Acct#). 

 
Tip: To make sure that you select the correct cell, you can click on the 
account number, first, to put your focus on the appropriate record. For 
more information, see Selecting Specific Records in the Navigating in General 
Ledger section. 

Activity details for the record are displayed in a window, as shown below. 

 

6 To print the current-period activity details, choose Print from the File 
menu. 

7 To close the detail window, click the x in the upper right corner of the 
window or choose Exit from the window’s File menu. 

You return to the main screen. 

8 To view year to date details for a single record in the list, double-click the 
cell in the YTD Activity column in the same row as the corresponding 
account number (Acct#). 

Year to date details for the record are displayed in a window. 

9 To print the year to date details, choose Print from the File menu. 
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10 To close the detail window, click the x in the upper right corner of the 
window or choose Exit from the window’s File menu. 

You return to the main screen. 

Viewing & Printing Account Summaries with Variances & Comments 

Trial Balance view enables you to view and print summary information and 
variances of all GL accounts for the current period. It also lets you add and 
view comments about the cause of variances. 

 To display a summary of accounts that includes variances and 
comments, do the following: 

1 If the Views label bar isn’t already open, click on it to display the various 
viewing options. 

2 In the Views slider bar, click the Trial Balance folder icon. 

The Trial Balance window appears. 

3 Select the site for which you want to display accounts from the Site drop-
down list at the top of the window. 

The window refreshes and displays information for the selected site, as 
shown below. 
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4 To view comments that have been entered for an account, click on any 
cell in the same row as the corresponding account number. 

If comments have been entered for that account number, they appear in 
the Comments text box at the bottom of the window. If no comment has 
been entered, the text box appears blank. 

 
Tip: The account number that you click on is displayed 
above the Comments text box. You can use this feature to 
make sure that you are focusing on the proper account. 

5 To print the Trial Balance report in the window, click the print button on 
the toolbar. 

 
Note: Trial Balance view printouts do not include 
comments. 

6 To close the Trial Balance window, click the exit button. 

You return to the main screen 

 To add a comment, do the following: 

1 Display the Trial Balance view by following the instructions above. 

2 Click on any cell in the same row as the account number for which you 
want to add a comment. 

 
Tip: The account number that you click on is displayed above 
the Comments text box at the bottom of the window. You 
can use this feature to make sure that you have selected the 
proper account. 

When you click a cell, the Comments text box becomes available for 
editing. 

3 Press the Enter key on your keyboard to move the cursor to the 
Comments text box. 

4 Enter your comment in the text box at the bottom of the window. 

5 Click anywhere outside the Comments box to save the comment you 
entered. 
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The comment you added remains with the account for the entire year. 
You can change it at any time by repeating the instructions above. You 
can view the comment in Trial Balance view by following the viewing 
instructions above. You can also view or change it in Operating 
Statement view (for more information, see Viewing & Printing Accounts in 
Operating Statement Format). 

6 To close the Trial Balance window, click the exit button. 

You return to the main screen. 

Viewing & Printing Accounts in Operating Statement Format 

Like Trial Balance view, Operating Statement view enables you to view and 
print summary information and variances for all GL accounts for the current 
period; and it lets you view and add comments. However, it is displayed in 
operating statement format, grouping accounts by revenues, expenses, and 
balance sheet accounts. Unlike Trial Balance view, you can print the 
comments for each account, along with the other account information. 

 To display a summary of accounts that include variances and 
comments in operating statement format, do the following: 

1 If the Views label bar isn’t already open, click on it to display the various 
viewing options.  

2 In the Views slider bar, click the Operating Statement folder icon. 

The Operating Statement window appears. 

3 Select the site for which you want to display accounts from the Site drop-
down list at the top of the window. 

The window refreshes and displays information for the selected site, as 
shown below. 
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4 To view comments that have been entered for an account, click on any 
cell in the same row as the corresponding account number. 

If comments have been entered for that account number, they appear in 
the Comments text box at the bottom of the window. If no comment has 
been entered, the text box appears blank. 

 
Tip: The account number that you click on is displayed 
above the Comments text box at the bottom of the window. 
You can use this feature to make sure that you are focusing 
on the proper account. 

5 To print the Operating Statement, click the print button on the toolbar. 

A message box appears, asking you if you want to print the comments, 
along with the other account information. 

6 If you want to include comments in the printout, click Yes. If not, click 
No. 

7 To close the Operating Statement window, click the exit button. 

You return to the main screen. 

 To add a comment, do the following: 

1 Display the Operating Statement view by following the instructions 
above. 
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2 Click on any cell in the same row as the account number for which you 
want to add a comment. 

 
Tip: The account number that you selected is displayed above 
the Comments text box at the bottom of the window. You 
can use this feature to make sure that you have clicked on the 
proper account. 

When you click a cell, the Comments text box becomes available for 
editing. 

3 Press the Enter key on your keyboard to move the cursor to the 
Comments text box. 

4 Enter your comment in the text box at the bottom of the window. 

5 Click anywhere outside the Comments box to save the comment you 
entered. 

The comment you added remains with the account for the entire year. 
You can change it at any time by repeating the instructions above. You 
can view the comment in Operating Statement view by following the 
viewing instructions above. You can also view or change it in Trial 
Balance view (for more information, see Viewing & Printing Account 
Summaries with Variances & Comments). 

6 To close the Operating Statement window, click the exit button. 

You return to the main screen. 

Viewing, Adding, & Updating Accounts in Master Templates 

Chart of Accounts view enables you to view the current master chart of 
accounts for each template or master list for each company division, (e.g., 
Multi-Family, Corporate, etc.). It also lets you add a new account and change 
information in an existing account. 

 
Tip: You can also add new accounts by using the New Account action. 
For instructions, see Adding New Accounts. 
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 To view, add, or modify accounts in a master chart of accounts 
template, do the following: 

1 If the Views label bar isn’t already open, click on it to display the various 
viewing options.  

2 In the Views slider bar, click the Chart of Accounts folder icon. 

A window appears, enabling you to select a master template to view. 

3 From the drop-down list in the center of the window, select the template 
that includes the master list of accounts you want to display (shown 
below). 

 

4 Click OK. 

You return to the main screen, which refreshes and displays the master 
list of accounts, as shown below. 



MultiSite Suite: General Ledger Module Viewing, Adding, & Updating Accounts in Master Templates 

MultiSite Systems, LLC version 2.2.96 21 

 

5 To view details of a specific account, double-click any cell in the same 
row as the corresponding account number. 

The account details appear in a window containing text boxes, as shown 
below. 

 

The selected record number is displayed at the bottom of the window. 

6 You can remain in the window and navigate to other accounts by doing 
the following: 
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 To navigate to the first record in the master list, click the first record 
button (  ). 

 To navigate to the previous record in the master list, click the 
previous button (  ). 

 To navigate to the next record in the master list, click the next button 
(  ). 

 To navigate to the last record in the master list, click the last record 
button (  ). 

7 To add a new account, click the Add button, enter information in the text 
boxes, and click the Update button. 

8 To modify information in an account, navigate to it using the instructions 
above and click the Edit button to make the text boxes available for data 
entry. Then change the information that you need to modify in the 
corresponding text boxes and click the Update button. 

 
Note: The Delete button is disabled, to prevent the deletion 
of accounts. If you need to delete an account, contact 
technical support. 

9 To close the detail window, click the Close button at the bottom of the 
window. 

You return to the main screen. 

Viewing Batches 

Batch view enables you to view unposted or posted batches (journal entries) 
for your company division and division template (Multi-Family for most 
users).  

While viewing batches, you can also display and modify the details of any 
batch in the list. 

 
Tip: Batch view is also useful for determining whether or not a batch 
has already been added to GL. This prevents duplication when adding 
batches to the system. 
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 To view a batch, do the following: 

1 If the Views label bar isn’t already open, click on it to display the various 
viewing options.  

2 In the Views slider bar, click the Batch folder icon. 

A message box appears, asking you if you want to add a batch. 

3 Do one of the following: 

 If you want to view batches before adding one to the system, click 
No. A list of batches appears in the main screen, as shown below. 

 If you are sure you want to add a batch right away, click Yes. The 
system automatically moves your focus to the Actions slider bar (for 
instructions on how to proceed, see Adding Batches). 

 

4 The system default is set up to display all unposted batches in your 
division. If you want to view posted batches, instead, choose Posted 
Batches from the View menu. To switch back to unposted batches, 
choose Unposted Batches from the View menu. 
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Tips:  

 If you select Filter Posted Batch Date Range from the View 
menu in the main screen menu bar, posted batches are 
filtered according to a specific date range, in order to 
shorten the list of records returned and avoid lengthy data 
retrieval times. You can change this date range in the Filter 
Posted Batches section of the Preferences window.  

 If the batches that appear are not from the company 
division you want, you can change the division by selecting 
an alternate one from the Default GL Template drop-down 
list in the Preferences window. 

For more information, see Setting User Preferences. 

5 To view or change details in any posted or unposted batch, double-click 
on any cell in the corresponding batch row. 

A batch detail panel appears in the main screen. 

If you are viewing unposted batches, the detail panel looks like this: 

 



MultiSite Suite: General Ledger Module  Managing Account Information (Actions) 

MultiSite Systems, LLC version 2.2.96 25 

If you are viewing posted batches, the detail panel looks like this: 

 

6 If you want to display the previous or next batch in the main list of 
batches without closing the detail window, use the up and down arrow 
buttons in the batch detail window toolbar. 

7 To print the batch details for the selected batch, click the Print button in 
the toolbar. 

8 To return to the main list of batches, click the Close Batch icon in the 
slider bar of the detail window. 

You return to the main screen. 

Managing Account Information (Actions) 

When you click the Actions label bar on the main screen of the GL module, 
the following icons appear in the Actions slider bar: 
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Note: Until you click an icon in the Actions slider bar, the other parts 
of the main screen remain in their previous view. In the picture above, 
the last icon clicked was the Inquiry icon in the Views slider bar; 
therefore, sites are listed in the center of the screen and the main panel 
displays the Inquiry list. 

Actions enable you to manage the account information in GL. Each yellow 
folder icon corresponds to a different action that you can select to add, 
modify, import, or export data. Descriptions of each action are as follows: 

 New Batch enables you to add a batch (journal entry) to GL or to 
import one from an Excel® spreadsheet. 

 Budgets enables you to manually add, view, or modify the budget for an 
individual site for a specified fiscal year. 

 Import Budget enables you to import a budget from a .csv file into GL. 

 New Account enables you to add a new account to GL. 

 Roll the Year enables you to transfer ending balances from one fiscal 
year to the beginning balance of the next fiscal year. 

 Calc YTD enables you To Whom It May Concern: recalculate the 
ending balance for year to date activity for all periods at once. 

Action icons 
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 Roll Up Tenant Transactions enables users in the corporate office to 
copy unposted account activities for selected sites and periods from the 
Tenant module and group them into one large batch of tenant records in 
GL. 

Adding Batches 

You can add a batch (journal entry) to GL in one of 3 different ways: 

 Clicking the Batch icon in the Views slider bar, and answering Yes in the 
“do you want to add a new batch?” message box. 

 Moving your cursor to the empty row at the bottom of a list of batches, 
and answering Yes in the “do you want to add a new batch?” message 
box. 

 Clicking the New Batch icon in the Actions slider bar. 

The instructions below explain how to add a batch by clicking the New 
Batch icon in the Actions slider bar. If you use one of the two other 
methods, simply follow the steps below, starting from step 3. 

 To add a new batch to GL, do the following: 

1 If the Actions label bar isn’t already open, click on it to display the 
available actions. 

2 In the Actions slider bar, click the New Batch folder icon. 

A panel appears inside the main screen with a batch header at the top and 
detail lines underneath. The icons in the Actions slider bar change to 
icons that pertain to adding batches. 
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3 In the Batch Type drop-down list, select one of the following: 

 JE lets you add journal entry line items for one site. 

 CJ lets you add a common journal entry, which enables you to enter 
line items for several sites in one batch or to import a file from Excel 
(for more information on importing Excel files, see Adding Batches by 
Importing Excel Files). 

4 Do one of the following: 

 If you selected JE, enter the site number in the Site # text box in the 
batch header. 

 
Tip: If you do not know the site number, double-click in the Site # text 
box to open the Search for a Site window. In the text box at the top of 
the search window, enter the first few letters of the site you want, or 
scroll down to find it. Then, double-click on the site you want. The 
search window closes and the system places the corresponding site 
number in the Site # text box of the batch header. 

When you move the cursor outside the Site # text box, the system 
validates the site number you entered. If the number you entered is 
valid, the name of the site appears on the right side of the Site # text 
box. If it is not valid, a “Site Number not found” message appears; 
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enter the number again until the system displays the correct site 
name. 

 
Tip: If you entered a valid site number and the system displays the “Site 
Number not found” message, then you probably need to change the 
company division template in which you are working. For instructions, 
see Setting User Preferences. 

 If you selected CJ, you do not enter a site number in the batch 
header; skip to step 5. 

5 Skip over the Batch ID text box. In the Calendar Period text box, accept 
or change the default calendar period. 

 
Tip: In almost all cases, you will accept the default calendar 
period. 

After you enter a valid site number and accept or change the calendar 
period, the system automatically enters the fiscal period in the batch 
header. 

6 If you want to add a reference number to the batch header, enter it in the 
Reference Number text box. Otherwise, leave it blank and skip to step 7. 

7 In the Description text box, enter a description for the batch you are 
adding. 

8 Ignore the text box to the right of the F button and skip to step 9. 

 
Tip: .The F button and text box enable you to import a batch from 
Excel, rather than adding one manually. For more information see 
Adding Batches by Importing Excel Files. 

9 Begin entering information in the detail line items (under General Ledger 
Detail Transactions). In the Site # cell of the detail lines, do one of the 
following: 

 If you selected JE in step 3, the site number appears in the Site # cell 
automatically. Skip to the next step. 

 If you selected CJ in step 3, select a site number for the current line 
item from the drop-down list in the cell. 
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Note: You can only enter line items for sites that use the same 
GL template (for more information, see Viewing, Adding, & 
Updating Accounts in Master Templates). Entries for sites with 
different GL templates should be entered as separate batches. 

10 If a Unit ID is applicable, enter it in the Unit cell. 

11 In the Acct # cell, enter an account number or select one from the drop-
down list (the drop-down list appears when you select the Acct # cell). 

12 Select the Description cell. 

The description that you entered in the Description text box of the batch 
header appears automatically. 

13 If you want to keep the batch header description, skip to the next step. If 
you want to change it, enter a new one in its place. 

 
Tip: While your cursor is inside the Description cell, you can press F2 
on your keyboard to move the cursor to the end of the description. This 
is helpful if you want to append some text at the end of the description. 

14 If the line item you are adding is a debit, enter a positive amount in the 
Debit cell. Otherwise, skip over the Debit cell and go to the next step. 

15 If the line item you are adding is a credit, enter a positive amount in the 
Credit cell. 

 
Note: Do not enter any negative numbers when adding batches to the 
system. 

16 If it isn’t already selected, select the Credit cell, then press the Tab or 
Enter key to go to the next blank line in the line items. 

17 Repeat steps 9 – 16 until all the line items you want to add to the batch 
are entered. 

18 At this point, if you want to remove the batch you just entered and start 
over again, you can click the Cancel Batch icon on the Actions slider bar 
and start over again from step 2. Otherwise, go to the next step to save 
your work. 
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Tip: The Delete Batch icon on the slider bar is for batches that have 
already been saved. The Cancel Batch icon is for batches that have not 
yet been saved. 

19 Click the Save Batch icon in the Actions slider bar. 

The system displays a message, indicating that the batch is saved.  

20 Click OK to close the message box. 

 
Note: If the batch you entered is out of balance (i.e., debits and credits 
are equal for each site), the system displays a warning about it. If that 
happens, edit the information in the batch so that it is in balance and 
save the batch again. 

21 After you save the batch, you can remove it by clicking the Delete Batch 
icon in the Actions slider bar. 

 
Note: You cannot delete a batch that has been posted (see the steps for 
posting a batch below). 

22 At this point in the process, you would typically post the batch that you 
just added and saved. To post it, follow the remaining steps below. If you 
want to post the batch later, click the Close Batch icon in the slider bar to 
return to the main Actions slider bar. 

23 To post the batch, click the Post Batch icon in the Actions slider bar. 

A message box appears, asking you if you want to post the batch.  

24 Check the calendar period that is displayed in the message box. If it is 
correct, click Yes in the message box. If it is not correct, change the 
calendar period to the one in which you want to post the batch. 

A message box appears, indicating that the batch was posted successfully 
to the current calendar period. 

25 Click OK to close the message box. 

A message box appears, asking if you want to print the contents of the 
batch. 

26 If you want to print a copy of the batch you just posted, click Yes. If not, 
click No. 
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1
2
3
4
5
6
7
8
9

A B C D
Site Account Description Amount

1 6540 Maintenance labor 100.00     
1 1100 Maintenance labor (100.00)    
2 6540 Maintenance labor 800.00     
2 1100 Maintenance labor (800.00)    
3 6540 Maintenance labor 400.00     
3 1100 Maintenance labor (400.00)    
4 6540 Maintenance labor 550.00     
4 1100 Maintenance labor (550.00)    

Whether you print the batch or not, you automatically return to the main 
Actions slider bar. 

 
Tip: A quick way to add a batch that is very similar to one that has 
already been saved is to copy the batch, change the values, save it, and 
post it (see Copying Batches). Or, you can reverse an existing batch (see 
Reversing Batches). 

Adding Batches by Importing Excel Files 

Some users prefer to create a long batch (journal entry) in Microsoft Excel® 
and then import the line items into GL, rather than entering line items into 
GL manually. MultiSite GL enables you to do that, provided that you adhere 
to a few simple formatting rules while working in Excel. 

 To create a batch in an Excel spreadsheet and import it into GL, do 
the following: 

1 Create a worksheet in Excel with the following four columns, in the 
following order, as shown in the graphic below: 

 Site Number (e.g., 123) 

 Account Number (e.g., 6450) 

 Description (e.g., Record Maintenance Labor) 

 Amount (e.g., 645.75) 

 
Notes: Row 1 in the Excel worksheet must contain the specified column 
headings, as shown in the example above. 

2 Enter two or more rows of data. Enter debits as positive amounts and 
credits as negative amounts. 
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Notes:  

 Sum the Amount column to make sure that it equals 0. Debits and 
credits must offset each other. 

 You can only enter line items for sites that use the same GL 
template. Entries for sites with different GL templates should be 
entered into separate Excel files and imported as separate batches. 

3 In the worksheet tab at the bottom of the spreadsheet, change the Excel 
default label so that it reads Text instead of Sheet1. 

4 Format the Amount column by doing the following: 

a) Select the entire Column D. 

b) From the Format menu in the Excel menu bar, choose Cells. 

c) In the Format Cells window, select the Number tab. 

d) In the Category list, select Accounting. 

e) In the Decimal Places box, make sure the value is 2 decimal places. 

5 Save the Excel file, giving it any name you want. 

 
Tip: You can have many other worksheets in the same workbook (.xls 
file), provided that the worksheet that you are importing into MultiSite 
GL is labeled Text, as described above. 

6 If you want to use the Excel file that you just saved as a master file, in 
order to import other batches into GL, do the following: 

a) In the File menu, choose Save As and save the file as a separate .xls 
file with a different name. 

b) Modify the Excel file so that the values reflect those in the other 
batch that you want to import. 

c) Save the file. 

You can import the modified, renamed file into GL at any time. 

 
Tip: For standard monthly journal entries, you can create 12 separate 
Excel files in this way (one for each month) at the beginning of the year 
and import them, as needed. 
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Note: It is advisable to create one or more master files from an Excel 
file before you import the file into GL because when you import it, GL 
adds a line at the bottom of the Excel file that prevents it from being 
imported again. 

7 Close the Excel file and exit Excel. 

8 Log into GL (for instructions, see Logging Into General Ledger). 

9 Click the Actions label bar to display the available actions. 

10 In the Actions slider bar, click the New Batch folder icon. 

A panel appears inside the main screen with a batch header at the top and 
detail lines underneath. The icons in the Actions slider bar change to 
icons that pertain to adding batches. 

 

11 In the Batch Type drop-down list of the batch header, select CJ 
(common journal entry). 

12 Skip over the Batch ID text box. In the Calendar Period text box, accept 
or change the default calendar period. 

 
Tip: In almost all cases, you will accept the default calendar 
period. 
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13 If you want to add a reference number to the batch header, enter it in the 
Reference Number text box. Otherwise, skip to the next step. 

14 In the Description text box, enter a description for the batch you are 
importing. 

 
Note: This Description field is the description for the batch header. 
Each detail line item will automatically contain the descriptions that you 
entered in the Excel file. 

15 Do one of the following: 

 In the Actions slider bar, click the Import Batch icon. 

 Click the F button in the batch header. 

A file selection window is displayed. 

16 Navigate to the directory containing the Excel file you saved. Click on 
the file name; then click Open. 

The system imports the data from the spreadsheet. When it is finished, it 
displays a message, asking if you want to save the batch that it just 
imported. 

17 Click Yes in the message box. 

The system adds a line at the bottom of the Excel file that displays your 
user name and date on which the file was imported. This prevents the file 
from inadvertently being imported a second time. 

 
Note: Before saving the file, the system checks it for valid site numbers, 
valid account numbers, and to see if the batch is in balance (i.e., debits 
and credits are equal for each site). If any of these are not correct, the 
system displays a warning about it.  

If that happens, click the Cancel Batch icon in the Actions slider bar. 
Then open the spreadsheet in Excel, edit the information so that it is in 
balance and all the site and account numbers are correct. Then repeat 
the instructions above, starting from step 5. 

If the system indicates that your site numbers are invalid and you know 
that they are correct, you probably need to change the company division 
template in which you are working. This is done in the GL Preferences 
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window. For instructions, see Setting User Preferences. 

18 After you save the batch, you can remove it by clicking the Delete Batch 
icon in the Actions slider bar. 

 
Note: You cannot delete a batch that has been posted (see the steps for 
posting a batch below). 

19 At this point in the process, you would typically post the batch. To post 
it, follow the remaining steps below. If you want to post the batch later, 
click the Close Batch icon in the slider bar to return to the main Actions 
slider bar. 

20 To post the batch, click the Post Batch icon in the Actions slider bar. 

A message box appears, asking you if you want to post the batch.  

21 Check the calendar period that is displayed in the message box. If it is 
correct, click Yes in the message box. If it is not correct, change the 
calendar period to the one in which you want to post the batch. 

A message box appears, indicating that the batch was posted successfully 
to the current calendar period. 

22 Click OK to close the message box. 

A message box appears, asking if you want to print the contents of the 
batch. 

23 If you want to print a copy of the batch you just posted, click Yes. If not, 
click No. 

Whether you print the batch or not, you automatically return to the main 
Actions slider bar. 

 
Tip: A quick way to add a batch that is very similar to one that has 
already been imported and saved is to copy the batch in GL, change the 
values, save it, and post it (see Copying Batches). Or, you can reverse an 
existing batch (see Reversing Batches). 
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Posting Batches 

If you add a batch or import a batch from an Excel file, and you do not post 
it right away, or if you create a batch from transactions in the Tenant module, 
you can post the batch to GL, afterwards, by using the instructions below. 

 To post a batch to GL, do the following: 

1 If the Views label bar isn’t already open, click on it to display the 
available viewing options. 

2 In the Views slider bar, click the Batch folder icon. 

A message box appears, asking you if you want to add a batch. 

3 In the message box, click No. 

A list of batches appears in the panel of the main window. 

4 If the label above the list of batches does not read “Unposted Batches,” 
(i.e., if it reads “Posted Batches), switch your view to Unposted Batches 
by choosing Unposted Batches from the View menu in the main screen 
menu bar. 

5 Double-click on any cell in the row that corresponds to the batch that 
you want to post. 

A panel containing batch details appears in the main screen, and the 
Actions slider bar opens, displaying the icons that pertain to batch 
activity. 
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6 Click the Post Batch icon in Actions slider bar to post the batch to GL. 

A message box appears, asking you if you want to post the batch.  

7 Check the calendar period that is displayed in the message box. If it is 
correct, click Yes in the message box. If it is not correct, change the 
calendar period to the one in which you want to post the batch. 

A message box appears, indicating that the batch was posted successfully 
to the current calendar period. 

8 Click OK to close the message box. 

A message box appears, asking if you want to print the contents of the 
batch. 

9 If you want to print a copy of the batch you just posted, click Yes. If not, 
click No. 

Whether you print the batch or not, you automatically return to the main 
screen. 

10 Click the Close Batch icon to return to the list of batches that you 
displayed in steps 2 and 3. 

11 If you want to post other batches in the list, repeat steps 5 - 10. 
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Copying Batches 

A quick and easy way to add a batch that is very similar to one that has 
already been saved to the system is to copy the batch, change the values, save 
it, and post it. 

 To copy a batch and use it to create a new batch, do the following: 

1 Display a list of posted or unposted batches that contains the batch you 
want to copy (for instructions, see Viewing Batches). 

2 Double-click on any cell in the row that contains the batch you want to 
copy.  

3 Click the Copy Batch icon in the Actions slider bar. 

The Copying New Batch panel appears in the main screen window. 

 

4 If you want to make any changes or additions to the batch details, you 
can do so at this point. 

5 Click the Save icon in the slider bar. 

6 Click the Close Batch icon to return to the list of batches. 
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7 In the View menu of the main menu bar, be sure that Unposted Batches 
is selected. If it is not, choose it from the menu. 

The unposted batches are displayed in a panel of the main screen. 

8 Find the copy of the batch you created and double-click on any cell in the 
corresponding row. 

The batch detail window appears. 

9 If you want to make any changes or additions to the batch details, you 
can do so at this point; then click the Save Batch icon. 

10 Click the Post Batch icon in Actions slider bar to post the batch to GL. 

A message box appears, asking you if you want to post the batch.  

11 Check the calendar period that is displayed in the message box. If it is 
correct, click Yes in the message box. If it is not correct, change the 
calendar period to the one in which you want to post the batch. 

A message box appears, indicating that the batch was posted successfully 
to the current calendar period. 

12 Click OK to close the message box. 

A message box appears, asking if you want to print the contents of the 
batch. 

13 If you want to print a copy of the batch you just posted, click Yes. If not, 
click No. 

Whether you print the batch or not, you automatically return to the main 
screen. 

Reversing Batches 

You can open any batch that has been saved in the system and create a new 
batch that switches (reverses) the debits and credits in the line items. The 
instructions are as follows: 
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 To create a new batch that reverses the debits and credits of an 
existing batch, do the following: 

1 Display a list of posted or unposted batches that contains the batch you 
want to reverse (for instructions, see Viewing Batches). 

2 Double-click on any cell in the row that contains the batch you want to 
reverse.  

3 Click the Reverse Batch icon in the Actions slider bar. 

The Reversing a Batch panel appears in the main screen window. 

 

4 If you want to make any changes or additions to the batch details, you 
can do so at this point. 

5 Click the Save icon in the slider bar. 

6 Click the Close Batch icon to return to the list of batches. 

7 In the View menu of the main menu bar, be sure that Unposted Batches 
is selected. If it is not, choose it from the menu. 

The unposted batches are displayed in a panel of the main screen. 
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8 Find the reversed batch you created and double-click on any cell in the 
corresponding row. 

The batch detail window appears. 

9 If you want to make any changes or additions to the batch details, you 
can do so at this point; then click the Save Batch icon. 

10 Click the Post Batch icon in Actions slider bar to post the batch to GL. 

A message box appears, asking you if you want to post the batch.  

11 Check the calendar period that is displayed in the message box. If it is 
correct, click Yes in the message box. If it is not correct, change the 
calendar period to the one in which you want to post the batch. 

A message box appears, indicating that the batch was posted successfully 
to the current calendar period. 

12 Click OK to close the message box. 

A message box appears, asking if you want to print the contents of the 
batch. 

13 If you want to print a copy of the batch you just posted, click Yes. If not, 
click No. 

Whether you print the batch or not, you automatically return to the main 
screen. 

Viewing, Adding & Updating Budgets 

The Budgets action enables you to view, add, or edit the budget for an 
individual site for any specified fiscal year. 

 To view, add, or update budgets for a site, do the following: 

1 If the Actions label bar isn’t already open, click on it to display the 
available actions. 

2 In the Actions slider bar, click the Budgets folder icon. 

The Budgets window appears. 
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The site name that appears at top of the window in the Site drop-down 
list in the window is the last site that was selected from Inquiry view (see 
Viewing & Printing Account Summaries). 

3 If you want to view, add, or edit a budget for a different site, select an 
alternate site from the Site drop-down list. 

4 In the Fiscal Year text box, enter the fiscal year for which you want to 
view or edit the site’s budget. 

5 Click the Get Budget button at the top of the window to display the 
budget records for the selected site and specified fiscal year. 

The budget data appears in the window. If no current budget exists for 
the fiscal year, the amounts in the line items will all be 0. 

 
Note: If you changed the site (in step 3), a message box appears, asking 
if you if you’re sure that you want to change sites before saving any data 
on the current screen. 

If this message box appears and you don’t need to save any information 
on the current screen, click Yes. If you entered data that you’ve not yet 
saved, click No, click the Save button at the bottom of the window, 
select the site you want from the Site drop-down list again, and click the 
Get Budget button again. 
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6 If you want to add or modify any data, select the corresponding cells and 
enter values. 

 
Tip: If a budgeted amount is the same for each month, it might be 
easier to spread the amount evenly. To do that, select cell in the Spread 
Amt. column in the same row as the corresponding account number 
(Acct #) and enter the annual amount. When you click anywhere 
outside the cell, the annual amount is spread evenly to each period in 
the record. 

7 If you changed any numbers in the record, click the Recalc Totals button 
at the top of the window to recalculate the budget accordingly. Then 
click the Save button at the bottom of the window. 

8 To print the budget, click the print button in the toolbar. 

9 To close the window, click the exit button. 

You return to the main screen. 

Importing Budgets 

You can import a budget from a .csv file into GL by following the steps 
below. 

 To import a budget, do the following: 

1 If the Actions label bar isn’t already open, click on it to display the 
available actions. 

2 In the Actions slider bar, click the Import Budget folder icon. 

The Import Budget window appears, as shown below. 
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3 Click the Start button at the bottom of the window. 

A window appears. 

4 In the window, navigate to the .csv file you want to import, select the file 
and click Open. 

The system begins importing the selected .csv file. The account numbers 
in the file flash in the Importing Account Number text box as the import 
progresses. 

 
Tip: At any time, you can abort the import process by clicking the Stop 
button at the bottom of the Import Budget window. 

When the import is finished, a “Done” message appears at the bottom of 
the window. 

5 Click the Close button to exit the Import Budget window. 

You return to the main screen.  

Adding New Accounts 

The New Account action enables you to add new accounts to GL. 

 
Tip: You can also add new accounts while you are viewing accounts in 
Chart of Accounts view. For instructions, see Viewing, Adding, & 
Updating Accounts in Master Templates. 
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 To add a new account to GL, do the following: 

1 If the Actions label bar isn’t already open, click on it to display the 
available actions. 

2 In the Actions slider bar, click the New Account folder icon. 

The Add Record window appears. 

 

3 RECOMMEND COPY ACCT TO ADD NEW ACCOUNTS 

4 From the GL Template drop-down list, select the GL Template 
(company division) associated with the account that you are adding. 

5 Complete the information in each of the blank text boxes.  

6 If the account is a Budget Account, select the BudgetAcct check box. 

7 If you want to add comments, enter them in the Comments text box. 

8 Click the Update button. 

The account is added to the system. You return to the main screen. 
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Rolling Ending Balances to the Next Year 

The Roll the Year action enables you to transfer ending balances from one 
fiscal year to the beginning balance of the next fiscal year. 

In the GL system, there are 14 available periods for each account in every 
year: periods 0 through 13. Period 0 (e.g. 002003 for the year 2003) receives 
values from the previous year end, periods 01-12 coincide with the 12 
calendar months in the year, and period 13 (e.g. 132003 for the year 2003) is 
where you add audit adjustments, year end closing numbers, and so forth. In 
this way, the system always maintains an accurate period 12. 

The Roll the Year action takes all the asset and liability accounts from period 
13 in a year and rolls them into period 0 of the following year. It also takes all 
the revenue and expense accounts, closes them out, and puts them in a 
specified account (typically owner’s equity) in period 0 of the following year. 

 
Notes: 

 The Roll the Year action should be done at least once each year, 
after all entries are posted. For more information, see Year End 
Procedures. 

 In the MultiSite Suite, periods and years are never officially “closed” 
per se. Entries can be made to previous periods and previous years. 
If an entry needs to be made to a previous year (e.g., for an audit 
related adjustment), it should be posted to the previous period, then 
the previous year should be recalculated (see Manual Updating the 
Ending Balance for Year to Date Activity). Then, the previous year 
should be rolled again and the new year should be recalculated 
again. 

 To transfer ending balances from one fiscal year to the beginning 
balance of the next fiscal year, do the following: 

1 If the Actions label bar isn’t already open, click on it to display the 
available actions. 

2 In the Actions slider bar, click the Roll the Year folder icon. 

The Roll Year window appears. 
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3 Do one of the following: 

 If you want to roll just one site, select the Roll One Site check box; 
then enter the site number you are rolling in the Site # text box that 
appears.  

(You do not need to select a Fiscal Year End when rolling just one 
site.) 

 If you want to roll all sites, keep the Roll One Site check box empty 
and select the year end from the Fiscal Year End drop-down list. 

Every site that has the selected fiscal year end appears in the Site# 
and Account# list box on the right side of the window. 

4 If you want to change the year that you are closing out, enter that year in 
the Enter the Year to Close Out text box. 

The new year (i.e., the following year) automatically appears in the 
window. 

5 Click the Roll the Year button. 

One of the following happens: 

 If you are rolling all sites, the system automatically selects each site 
number in the Site# list box, one at a time, and displays the 
corresponding account numbers in the Account# list box as the 
system rolls them over. 
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 If you are rolling just one site, the system automatically displays the 
account numbers for the site you entered in step 3 in the Account# 
list box as the system rolls them over. 

When all accounts are all rolled over, a “finished rolling the year” 
message appears. 

6 If you want to recalculate the year to date activity for each site for the 
new year at this point, click the Calc YTD button. 

When the recalculation is complete, a “Finished Calculated YTD” 
message appears in the Roll the Year window. 

7 Click the Quit button to close the Roll the Year window. 

You return to the main screen. 

 
Tip: You can use the Roll the Year action as often as you want to 
without causing any repercussions to the data in the system. It is better 
to do this too often than not often enough. 

Manual Updating the Ending Balance for Year to Date Activity 

The Calc YTD action enables you to manually recalculate the ending balance 
for year to date activity for all periods at once.   

When you post a journal entry to a particular period (month), the system 
automatically updates all activity (including the year to date activity) for that 
period, and updates the ending balance for the year to date activity for the 
remaining periods for the fiscal year. The Calc YTD action updates the year 
to date fields in each period, based on previous monthly amounts. You can 
do this for one site or for all sites, simultaneously should the need arise.   

 
Notes:  

 This procedure updates the summary table of account balances. If 
you notice beginning balances for the next month do not equal your 
ending balance for the previous month you should run this 
procedure to fix the beginning balances and ending balances. For 
more information, see Month End Procedures). 

 In the MultiSite suite, periods and years are never officially “closed” 
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per se. Entries can be made to previous periods and previous years. 
If an entry needs to be made to a previous year (e.g., for an audit 
related adjustment), it should be posted to the previous period, then 
the previous year should be recalculated. Then, the previous year 
should be rolled again) and the new year should be recalculated 
again. 

 To recalculate the ending balance for year to date activity for all 
periods in a fiscal year, do the following: 

1 If the Actions label bar isn’t already open, click on it to display the 
available actions.  

2 In the Actions slider bar, click the Calc YTD folder icon. 

The Recalculate YTD window appears. 

 

3 Do one of the following: 

 If you want to recalculate year to date activity for one site, enter the 
site number in the Site No. text box. 

 If you want to recalculate year to date activity for all sites, click the 
All sites check box. 

A list of all sites appears in a list box on the right side of the window. 

4 In the Fiscal Year text box, enter the fiscal year for which you want to 
recalculate the ending balance for year to date activity. 

5 Click the Calc YTD button. 
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The account numbers for the selected site(s) flash in the Account No. 
text box as the system updates their year to date activity. When this 
process is finished, a “Done” message appears at the bottom of the 
Recalculate YTD window. 

6 To close the window, click the x in the top right corner. 

You return to the main screen. 

 
Tip: You can use the Calc YTD action as often as you want to without 
causing any repercussions to the data in the system. It is better to do 
this too often than not often enough. 

Creating Tenant Batches in General Ledger –SKIP IF USING REAL 
TIME POST 

The Roll Up Tenant Transactions action enables users in the corporate office 
to copy accounts for selected sites from the Tenant module into the GL 
module, create a large batch of those accounts in GL, post the batch to GL, 
and mark the accounts as posted in the Tenant module. 

This feature was added to GL because many companies prefer to balance 
their own accounts on a monthly basis. Therefore, tenant account 
information is not exported from the Tenant module to the GL module 
automatically, and the information must be updated in GL manually so that 
the GL records are correct. 

 
Note: If the MultiSite Tenant module is being used, this action should 
be performed at least once each month, to keep the records in GL 
accurate. If preferred, it can be done more than once each month. 

 To create a tenant batch in General Ledger, do the following: 

1 If the Actions label bar isn’t already open, click on it to display the 
available actions. 

2 In the Actions slider bar, click the Roll Up Transactions folder icon. 

The Tenant Transactions Roll Up window appears. 
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3 In the Period to Roll Up text box, accept the default period or change it 
to the period for which you want to create a batch of tenant account 
records. 

4 Click the Select Site(s) button. 

The Select Sites window appears. 

 

5 Select the sites you want to include by clicking anywhere in the rows that 
contain the corresponding site names. Hold down the Shift key while 
doing this to select contiguous rows of sites; hold down the Ctrl key to 
select non-contiguous rows. 

6 Click OK at the bottom of the window. 

The system does all of the following: 

 Copies from the Tenant module all unposted tenant charges and 
receipts, rental assistance charges and receipts, security deposit 
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receipts, and other activities for the sites you selected and the period 
you specified and groups them together into one large batch in GL.  

 Copies from the Tenant module all unposted account activities for 
the sites you selected and all the periods prior to the one you specified 
and groups them together into separate batches in GL (a different 
batch for each period of unposted activities). 

 Marks the accounts that were included in the batch (or batches) as 
posted in the Tenant module.  

A status bar is displayed as the system completes these processes. When 
the system is finished, a message box appears that reads “Roll Ups 
Complete.” 

7 Click the Close button in the message box. 

You return to the GL Transactions Roll Up window.  

8 Click the Close button in the GL Transactions Roll Up window. 

You return to the main screen. 

 
Tips:  

 After the system creates the batch, you can view it in GL by clicking 
the Batch folder icon in the Views slider bar (see Viewing Batches). 

 To view or print the details in the batch, run the report called 
“Tenant Roll Up to GL” (see Generating & Printing Reports). 

9 Post the batch (for instructions, see Posting Batches). 

Month End Procedures – DIFFERENT IF USING REAL TIME POST 

The following procedures should be done at the end of each month for each 
property before batches (journal entries) are entered into the system for the 
following month. 

 At the end of each month, do the following: 

1 In the Tenants module, generate the Tenant Summary report, and verify 
that Gross Rent Potential (GRP) is in balance (i.e., make sure that the 
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actual amounts charged are equal to the budgeted amounts) and that 
Cash is correct. 

 
Tip: The detail records used to generate the Tenant Summary report are 
the same records as those used to create tenant batches. If the Tenant 
Summary report is correct, the batch of tenant records that gets posted 
in GL will also be correct. 

2 Use the Creating Tenant Batches in General Ledger procedure in this manual 
to create a batch for each site for each period that has unposted Tenant 
transactions. 

 
Note: If a user working in the Tenant module inadvertently creates 
Tenant transactions for a period prior to the one for which you are 
creating the current batch, the system will automatically place the prior 
transactions in separate GL batches (a different batch for each period). 

 
Tip: To view the details in the batch created from the Tenant module, 
print the Tenant Roll Up to GL report and compare it to the Tenant 
Summary report. (For instructions, see Generating & Printing Reports.) 

3 Post the batch that you just created from the Tenants module. For 
instructions, see Posting Batches. 

4 Print the financial statements that are pertinent to your company (e.g., 
the Trial Balance, Operating Statement, Cash Flow report). For 
instructions, see Generating & Printing Reports. 

Year End Procedures 

The following year end procedures must be done for every property when 
the numbers for the closing year are finalized and before any January batches 
(journal entries) are entered into the system for the new year. 

 At the end of each year, do the following: 

1 In user preferences, change the default period to 13 (e.g., 132003 for 
period 13 of the year 2003). For instructions, see Setting User Preferences. 

2 Enter any year end batches. For instructions, see Adding Batches or Adding 
Batches by Importing Excel Files. 
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Tip: Typically, these would be batches resulting from audit adjustments 
in period 13 of the prior year. 

3  

4 Use the Roll the Year action to take the ending balance (from period 13) 
of the prior year and copy (“close”) them to the beginning balances 
(period 0) of the following year. For instructions, see Rolling Ending 
Balances to the Next Year. Then complete step 5 immediately. 

All P & L accounts are “rolled up” and closed into the equity account 
that was set up in the account template. All assets and liabilities will 
simply roll over and become the beginning balance of the new year. 

 
Tip: The Roll the Year action can be done at any time, and it can be 
done more than once. However, it must always be immediately 
preceded by recalculating the year to date activity for the prior year (step 
3 above), and it must always be immediately followed by recalculating 
the new year (step 5 below). 

5 Use the Calc YTD action to update the ending balance for all year to date 
activity for the new year. For instructions, see Manual Updating the Ending 
Balance for Year to Date Activity. 

6 Change the default period in user preferences to 01 of the new year, to 
enter batches for January. For instructions, see Setting User Preferences. 

Generating & Printing Reports 

There are two icons on the Reports slider bar that you use to generate 
reports: one that displays a list of reports to select (Other Reports) and one 
that generates the Cash Flow report (Cash Flow). A separate icon is necessary 
for the Cash Flow report because the system must perform some additional 
processing to retrieve that report. 

After you generate a report, it is displayed in the Reports window, where you 
can view the report, print it, export it to a file, or send it as an e-mail 
attachment. Instructions for each of these procedures follow. 
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Generating Regular Reports (Reports Other Than Cash Flow) 

 To generate any report other than the Cash Flow report, do the 
following: 

1 If the Reports label bar isn’t already open, click on it to display the two 
Reports icons. 

 

2 In the Reports slider bar, click the Other Reports icon. 

The GL Report Menu window appears, as shown below. It displays the 
reports that are assigned to you. 

 
Note: If a report that you expect to see does not appear, speak to your 
supervisor or system administrator about adding the report to your 
assigned list. 

 

3 Scroll down the list of reports until you find the one you want to view. 
Then click on the report name to select it. 
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Tip: An arrow appears in the selection bar next to the report that you 
selected. A description of the report is displayed in the Report 
Description box at the bottom of the window. 

4 Do one of the following: 

 Click the All icon in the Preview slider bar on the right side of the 
GL Report Menu window. 

 Double-click on the report name. 

If report parameters are associated with the selected report, a report 
parameters window appears. Each parameter window contains different 
options, depending on which report you selected in step 3. 

5 Select and/or enter the parameter values by which you want to filter the 
selected the report. 

6 Click OK. 

The selected report appears in the Reports window, as shown below. 

 

7 To navigate in the report, print the report, export it to a file, or send it to 
someone as an e-mail attachment, use the instructions in the Navigating in, 
Printing, Exporting, and E-mailing Reports section below. 
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8 To close the Reports window, click the x button on the toolbar or in the 
upper right corner of the window. 

You return to the GL Report Menu window.  

9 Click the Close Reports icon in the Preview slider bar of the GL Report 
Menu window.  

You return to the main screen. 

Generating the Cash Flow Report and other Icon Reports 

 To generate the Cash Flow report, do the following: 

1 If the Reports label bar isn’t already open, click on it to display the two 
Reports icons. 

2 In the Reports slider bar, click the Cash Flow icon. 

 

The Cash Flow window appears. The current default period appears in 
the Enter Period text box. 

 

3 If you are generating a report for a different period, enter it in the Enter 
Period text box. Otherwise, accept the default period. 

4 Click the Select Site(s) button. 

The Select Sites window appears. 
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5 Select the sites you want to include by clicking anywhere in the rows that 
contain the corresponding site names. Hold down the Shift key while 
doing this to select contiguous rows of sites; hold down the Ctrl key to 
select non-contiguous rows. 

6 Click OK at the bottom of the window. 

The system displays the report in the Reports window. 

7 To navigate in the report, print the report, export it to a file, or send it to 
someone as an e-mail attachment, use the instructions in the Navigating in, 
Printing, Exporting, and E-mailing Reports section below. 

8 To close the Reports window, click the x on the toolbar or in the upper 
right corner of the window. 

You return to the Select Sites window.  

9 Click the x in the upper right corner of the Select Sites window. 

You return to the GL Report Menu window. 

10 Click the Close button in the GL Report Menu window.  

You return to the main screen. 
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Navigating in, Printing, Exporting, and E-mailing Reports 

Use the toolbar buttons and labels (shown below) to navigate among the 
report pages, print the report, export the report to a computer file, and/or 
send the report as an e-mail attachment to a specified e-mail recipient. 

 

Explanations of each button and label (in sequential order from left to right) 
are as follows  

 Use “X” in top right of report form to close the window. 

 The first left-arrow goes to the 1st page in the report. 

 The second left-arrow goes to the previous page in the report. 

 The “1 of 2” indicates the page number that is currently displayed (page 
1), followed by the total number of pages (2 pages). 

 The first right-arrow goes to the next page in the report. 

 The last right-arrow goes to the last page in the report. 

 The square stops the viewer from searching for a particular page. You 
can use this button if you click the 1st page button or last page button, 
and it is taking too long for the viewer to find the page, due to the length 
of the report. The reports window displays whatever page the system is 
retrieving at the moment you click this stop button. 

 The print button prints the report.  You can choose your PDF Priner. 

 The button to left of printer button is the export button. It opens a 
standard export window that enables you to export the report to a file or 
to send it as an e-mail attachment to an e-mail address that you specify.  
You have to have email setup on your server for this to work. 

 The 100% drop-down list enables you to select different sizes in which to 
view the current page, creating the effect of zooming in and out. 

 The number next to “Total” indicates the total number of records that 
are in the report. 

 Two blue circular arrows is Refresh Button allowing you to choose 
different parameters. 
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 Use Binocular icon to Find text or numbers. 

Setting User Preferences 

The user preferences feature enables you to set the default values that the 
system uses to filter records that you retrieve from the GL database. You can 
set any of the following defaults: 

 The current period in which you view and manage records throughout 
GL.  

 The company division for which sites appear when you view account 
summaries (see Viewing & Printing Account Summaries). 

 The company division template for which you view batches (see Viewing 
Batches).  

 When you filter records by property manager or office, it lets you specify 
which manager or office will be used to filter the records. 

 When you filter posted batches, it lets you set the date range of the 
posted batches that the system retrieves.  

For more information about filtering records, see Filtering Records for 
Customized Viewing in the Viewing & Printing Account Information (Views) 
section.) 

The user preferences feature also enables you to set the default location on 
your computer system where the system stores reports and documents that 
you export in GL. 

 To set user preferences, do the following: 

1 In the main screen, do one of the following: 

 Click the User Preferences button in the toolbar. 

 From the Tools menu, choose Preferences. 

The Preferences window appears, and the General tab is displayed 
(shown below). 
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2 If you want to change the current period in which you want to view and 
manage account data, enter the period in the Session Current Period text 
box. 

 
Note: When you change the default current period, the new default 
value only appears during the current session. When you exit GL, the 
default current period automatically resets to the actual current period. 
The actual current period is set by the system administrator at the 
beginning of each period. 

3 If you want to change the location where the system saves and stores 
exported reports, double-click inside the Default Report Location text 
box. Then, in the browse window that appears, select the alternate 
location in the file directory. 

4 If you want to change the location where the system saves and stores 
exported documents, double-click inside the Default Document Location 
text box. Then, in the browse window that appears, select the alternate 
location in the file directory. 

 
Note: Currently, there are no documents that are generated in GL. The 
Default Document Location preference is for future reference. 

5 If you want to change the company division for which you view account 
summaries, select the division from the Default Division drop-down list. 
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The list of sites that appears when you select the Inquiry icon from the 
Views slider bar will be filtered accordingly. 

6 If you want to change the company division template for which you view 
batches, select the template from the Default GL Template drop-down 
list. 

The list of batches that appears when you select the Batch icon from the 
Views slider bar will be filtered accordingly. 

 
Tip: If you add batches to GL and the system won’t accept them, 
indicating that the site numbers are wrong, and you know that you have 
entered the site numbers correctly, you probably need to change the 
company division template in which you are working. 

7 If you are filtering records by property manager and you want to switch 
to a different property manager’s accounts, select the manager from the 
Default Property Manager drop-down list. 

The accounts that appear when you choose Filter PM from the View 
menu will be filtered accordingly. 

8 If you are filtering records by office and you want to switch to accounts 
from a different office, select the office from the Default Office drop-
down list. 

The accounts that appear when you choose Filter Office from the View 
menu will be filtered accordingly. 

9 To change the date range in which the system filters posted batches, 
enter the starting date in the Filter for Batch Dates Beginning text box; 
then enter the ending date in the Filter for Batch Dates Ending text box.  

 
Tip: Both text boxes are located in the Filter Posted Batches group box 
in the lower right corner of the General tab of the Preferences window. 

The batches that appear when you select the Batch icon in the Views 
slider bar will be filtered accordingly. 

10 Click the Save Settings button. 

11 If you want to enter other preferences, click on the other tabs in the 
Preferences window and change the default settings in those tabs. Be sure 
to click the Save Settings button after working in each tab. 
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12 Click the Close button to close the Preferences window. 

You return to the main screen. 

Setting Reminders 

You can set reminders for yourself in the General Ledger system. The system 
displays the reminders when you log into the system, so that you won’t forget 
important tasks. For example, if you set a reminder for every Thursday, the 
system displays the reminder every Thursday, as soon as you log into GL. 

 
Note: In order for the system to display reminders, the Show 
Reminders command on the Tools menu must be selected. 

 To set reminders, do the following: 

1 From the Tools menu of the main screen, choose Show Reminders. 

The Reminders window appears. 

 

2 Click the Add Reminder button. 

The Add Reminder window appears. 
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3 In the Beginning Date text box, select or enter the date on which you 
want the reminder to start. 

4 In the Ending Date text box, select or enter the date on which you want 
the reminder to end. 

5 In the Subject text box, enter the subject of the reminder. 

6 In the Description text box, enter a detailed description of the reminder. 

7 In the Reminder Frequency list, select the frequency with which you want 
to be reminded. 

8 Click the Save button. 

A message box appears, indicating that the reminder has been saved in 
the system. 

9 Click OK in the message box. 

10 To exit the window, click the x button in the top right corner or the 
Close button in the bottom part of the window. 

You return to the Reminders window.  

11 To add another reminder, repeat steps 2-10. 

12 To exit the Reminders window, click the x button in the top right corner 
or the Close button in the bottom part of the window. 

You return to the main screen. 
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Tip: After you add reminders, they appear in a list in the Reminders 
window according to the frequency that you set in step 7. You can 
dismiss a reminder by clicking inside the corresponding check box in 
the Dismiss column. You can also dismiss all related reminders by 
clicking inside the corresponding check box in the Clear All column. If 
you use these features to dismiss reminders, they do not appear in the 
Reminders window when you log into the system. 

Displaying the Windows Notepad & Calculator 

If you want to open the Windows Notepad® or Calculator® to use while 
you are working in GL, choose Notepad or Calculator from the Tools menu. 

Rebuilding Layout Files 

Your system contains a configuration file that determines which GL icons 
and features appear in your own customized version of the GL screen and 
which ones do not. Sometimes this file gets corrupted. When that happens, 
the Rebuild Layout Files feature restores the system defaults so that your GL 
screens and windows will work properly again. 

You should not rebuild layout files on your own. However, if you are 
experiencing technical difficulty, a customer support technician may ask you 
to use this feature. If that happens, then simply choose Rebuild Layout Files 
from the Tools menu. 


